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0  
1 ISOLATION OF DNA 

 
1.1 Technical Notes 

 
1.1.1 The QIAamp® extraction procedure uses spin columns to extract/purify DNA from buccal samples and 

dried blood stains. The QIAGEN® AL lysis buffer, included in the QIAamp® extraction kit, is a 
guanidine-based buffer. The guanidine helps to set up the binding conditions needed for the DNA to 
adhere to the spin column membrane. The QIAGEN® AL lysis buffer also contains a detergent to rupture 
leukocyte nuclear membranes which exposes the nucleic acids. 

 
1.1.2 The QIAGEN® protease is similar to, but less stringent than ProK, and serves the same purpose for the 

breakdown of proteins into their constituent amino acids. The DNA yield reaches a maximum after lysis 
for 10 min at 56o C. Longer incubation times have no effect on the overall yield of the purified DNA. 

1.1.3 The QIAGEN® AW1 wash buffer is an ethanol-based stringent wash solution containing a low 
concentration of guanidine. This wash step removes any non-specific binding to the spin column 
membrane. 

 
1.1.4 The QIAGEN® AW2 wash buffer is a Tris-based solution containing ethanol which will wash away any 

salts that are present. 
 
1.1.5 The QIAGEN® AE elution buffer is a Tris-EDTA solution which elutes the DNA attached to the 

membrane and serves as a stable storage medium. Due to the high concentration of EDTA in this Qiagen-
supplied reagent, all database samples will be eluted in Type I water to help prevent inhibition during the 
amplification process. 

 
1.1.6 A random sample will be run with each set of convicted offender and arrestee sample extractions to serve 

as a verification that the samples are successfully entered into Combined DNA Index System (CODIS) 
and the search algorithm is working properly. This sample serves as an internal laboratory control and 
must be verified by the State CODIS Administrator or designee prior to the sizing data being considered 
acceptable. If a sample must be re-extracted a new random sample must be extracted along with the 
sample. 

 
1.1.7 Routinely the QIAGEN BioRobot® UNIVERSAL SYSTEM is used to isolate DNA from convicted 

offenders blood/buccal or arrestee buccal samples in accordance with the procedures manual. However, 
when necessary convicted offender blood/buccal and arrestee buccal samples may also be extracted using 
the manual QIAamp® Extraction Procedure.  

 
1.2 Equipment  

 
• Heat block or incubator, 56 oC 
• Microcentrifuge 
• Vortex mixer 
• Tweezers 
• Pipettes - 10 µL, 20 µL, 100 µL, 200 µL, 1000 µL 
• Hole punch or scissors 

 
1.3 Materials 

 
• Microcentrifuge tubes, 1.5 mL 
• Transfer pipettes 
• Aerosol-resistant tips for pipettes, 10 µL, 20 µL, 100 µL, 200 µL, and 1000 µL 
• QIAamp® spin columns 
• QIAamp® 2-mL collection tubes 
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1.4 Reagents 

 
• 95% Ethanol/Reagent Grade  
• 1X phosphate-buffered saline (PBS), pH 7.2  
• QIAGEN® protease  
• QIAGEN® AL lysis buffer  
• QIAGEN® AW1 wash buffer  
• QIAGEN® AW2 wash buffer  
• Type I Water 

 
1.5 Manual QIAamp® Extraction Procedure– Arrestee and Offender Samples 
 

1.5.1 Dried blood stains/buccal: Cut a 3 - 5 mm2 blood stain/buccal or using a hole puncher, punch one hole 
from the dried blood stain/buccal and transfer to a labeled 1.5 mL microcentrifuge tube. The scissors or 
hole punch should be cleaned between each punch using 10% bleach followed by isopropanol. 

 
1.5.2 Add 180 µL PBS buffer to each tube and pulse spin to force the blood stain/buccal into the buffer. 

Incubate at 56 °C for ten minutes. 
 
1.5.3 Add 20 µL of the QIAGEN® protease to each tube and vortex for 15 seconds to thoroughly mix the 

sample. 
 

WARNING! 
 

The QIAGEN® AL lysis buffer contains Guanidine Hydrochloride. This chemical will produce 
chlorine gas when mixed with bleach. When cleaning the counter tops after using the QIAGEN® 
extraction method wash the counter top first with water, then isopropanol, followed by a 10% 
bleach solution to disinfect the area. 

 
1.5.4 Add 200 µL of the QIAGEN® AL lysis buffer to each tube. Vortex the tube for 15 seconds to thoroughly 

mix the sample. 
 
1.5.5 Incubate the tube in a 56 °C heat block for 10 minutes. Pulse spin before opening. 
 
1.5.6 Add 200 µL 95% ethanol to each tube. Vortex the tube for 15 seconds to thoroughly mix the sample. 

Pulse spin before opening. 
 
1.5.7 Transfer the supernatant from the tube to a labeled QIAamp® spin column that is inside of a 2.0 mL 

collection tube. Centrifuge the sample for 1 minute at 8,000 rpm.  
 

NOTE: Be careful not to apply the sample to the rim of the spin column. Sample that has been deposited 
on the rim during the centrifugation will be transferred from the tube to the inside of the 
microcentrifuge. 

 
1.5.8 Discard the 2.0 mL collection tube containing the filtrate and place the QIAamp® spin column into a 

clean 2.0 mL collection tube. 
 
1.5.9 Add 500 µL of the QIAGEN® AW1 wash buffer and centrifuge for 1 minute at 8,000 rpm. 
 
1.5.10 Discard the 2.0 mL collection tube containing the filtrate and place the QIAamp® spin column into a 

clean 2.0 mL collection tube. 
 
1.5.11 Add 500 µL of the QIAGEN® AW2 wash buffer and centrifuge for 3.5 minutes at 13,200 rpm. 
 
1.5.12 Discard the 2.0 mL collection tube containing the filtrate and place the QIAamp® spin column into a 

clean, labeled 1.5 mL microcentrifuge tube. 
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1.5.13 Add 50 µL of Type I water to each QIAamp® spin column. 

 
1.5.14 Incubate the sample at room temperature for 1 minute. 
 
1.5.15 Place the 1.5 mL microcentrifuge tube containing the QIAamp® spin column into a microcentrifuge and 

spin for 1 minute at 8,000 rpm. 
 
1.5.16 Discard the QIAamp® spin column and cap the 1.5 mL microcentrifuge tube containing the extracted 

DNA sample. Extracted DNA samples should be stored at -20°C.
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2 PCR AMPLIFICATION 
 
2.1 Technical Notes 

 
2.1.1 The PowerPlex® Fusion System contains 24 sets of primers and allows for the co-amplification and five-

color detection of the 13 core CODIS (US) loci (CSF1PO, FGA, TH01, TPOX, vWA, D3S1358, 
D5S818, D7S820, D8S1179, D13S317, D16S539, D18S51 and D21S11), the 12 core European Standard 
Set loci (TH01, vWA, FGA, D21S11, D3S1358, D8S1179, D18S51, D10S1248, D22S1045, D2S441, 
D1S1656 and D12S391), Amelogenin, DYS391, Penta D, Penta E, D2S1338 and D19S433. 

 
2.1.2 The PowerPlex® Fusion System provides all materials necessary to amplify STR regions of human 

genomic DNA, including a hot-start thermostable DNA polymerase, which is a component of the 
PowerPlex® Fusion 5X Master Mix. 

 
2.1.3 The PowerPlex® Fusion System may be utilized with either extracted DNA (Qiagen) or as a direct 

amplification system for convicted offender/arrestee database samples. 
 

2.1.4 A random sample will be run with each set of convicted offender and arrestee sample amplifications to 
serve as a verification that the samples are successfully entered into Combined DNA Index System 
(CODIS) and the search algorithm is working properly. 

 
2.1.5 If a sample must be re-amplified, the random sample does not need to be re-amplified, providing that the 

random sample has typed correctly. The reagent blank also does not need to be re-amplified, provided the 
reagent blank is clear. However, the Control DNA (positive amplification control) and negative 
amplification control must be amplified with the re-amplified sample. 

 
2.2 Equipment 

 
• 9700 Thermal Cycler  
• Pipettes - 2 µL, 10 µL, 20 µL, 100 µL, 200 µL and/or 1000 µL 
• 8- Channel Pipette – Range 0.5 µL to 10 µL 
• Repeat pipetter – Range 1.0 µL to 1.25 mL 
• Biological Safety Hood 
• Microcentrifuge tube racks 
• 1.2 mm Harris Micro-Punch® and cutting mat or BSD® semi-automated punch system  
• 70°C heat block 

 
2.3 Materials 

 
• Aerosol-resistant pipette tips - 10 µL, 20 µL, 100 µL, 200 µL and/or 1000 µL 
• 1.5 mL microcentrifuge tubes 
• 0.2 mL amp tubes or 96-well amplification plates and strip caps 
• 96-well plate adhesive tape 

 
2.4 Reagents 
 

• PowerPlex® Fusion System 5X Primer Pair Mix (component of Fusion kit) 
• PowerPlex® Fusion System 5X Master Mix (component of Fusion kit) 
• Water, Amplification grade (component of Fusion kit) 
• Control DNA (2800M positive amplification control) (component of Fusion kit) 
• PunchSolution™ reagent (for direct amp use) (component of PunchSolution™ kit) 
• 5X AmpSolution™ reagent (for direct amp use) (component of PunchSolution™ kit) 

 
NOTE: A dedicated area, such as a biological hood or a separate room, should be used for preparing PCR 

amplification reactions. All equipment and supplies used to prepare amplification reactions should be 
kept in this dedicated "clean" area at all times. Do not use these items to handle amplified DNA or other 
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potential sources of contaminating DNA. Trace amounts of amplified DNA, if carried over into other 
samples before amplification, can lead to results that can be misinterpreted. DO NOT bring amplified 
DNA, or equipment and supplies used to handle amplified DNA, into the designated "clean" area. Wear 
clean disposable laboratory gloves while preparing samples for PCR amplification. Change gloves 
frequently or whenever there is a chance they have been contaminated with DNA. 

 
2.5 PowerPlex® Fusion System Amplification Procedure for Extracted DNA (27 cycle half-volume reaction) 
 

2.5.1 Calculate the required volume of each PCR amplification component to prepare a master mix by 
multiplying the volume by the number of samples. This should include a reagent blank, a random sample, 
positive and negative amplification controls and additional reaction volumes to compensate for any 
pipetting variation. The PCR Master Mix should be prepared in a clean 1.5 mL microcentrifuge tube. 

 
Half Reaction Master Mix, 12.5 µL total volume, consists of: 
 

2.5 µL PowerPlex® Fusion 5X Master Mix 
2.5 µL PowerPlex® Fusion 5X Primer Pair Mix 
7.5 µL DNA + Amplification grade Water 

    
2.5.2 Add 5.0 µL of PCR Master Mix to each labeled tube or well of the 96 well plate using aerosol-resistant 

tips or repeat pipetter.  
 

NOTE: If using a plate format, once all of the master mix is distributed, each column of the 
amplification plate should be covered with a strip cap. During the DNA transfer using the 8-
channel pipetter, only one column should be opened at a time on both the extracted DNA plate 
as well as the amplification plate. 

 
2.5.3 Prepare the sample DNA and controls as follows: 

 
2.5.3.1 Dried blood stains/buccal cells/random sample: Add 1.0 – 7.5 µL of extracted DNA to the 

appropriately labeled sample tube or well. Bring the total DNA sample volume up to 7.5 µL 
by adding Amplification Grade Water to the tube or well. 
 
NOTE: Weaker/difficult samples may require a higher volume to obtain a complete DNA 

profile. 
 

2.5.3.2 Positive Amplification Control: Add 0.3 µL of the stock Control DNA to the appropriately 
labeled sample tube or well. Add 7.2 µL Amplification Grade Water to the tube or well. 

 
2.5.3.3 Negative Amplification Control: Add 7.5 µL of amplification grade water to the 

appropriately labeled sample tube or well.  
 

2.5.3.4 Reagent Blank: Add up to 7.5 µL of the reagent blank to the appropriately labeled sample 
tube or well. The volume added must match the maximum volume of DNA added to any 
sample in the amplification. Bring the total sample volume up to 7.5 µL by adding 
Amplification Grade Water to the tube or well. 

 
2.5.4 Place the 96 well amplification plate or tubes into the 9700 thermal cycler. Move the thermal cycler lid 

over the samples and tighten. 
 

2.5.5 Extracted DNA: Amplification Parameters for the 9700 Thermal Cycler: 
 

2.5.5.1 96°C for 1 minute, then: 
 
94°C for 10 seconds 
59°C for 1 minute 
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72°C for 30 seconds 
For 27 cycles, then: 
 
60°C for 10 minutes 
 
4°C soak 
 
The program must be run with Max mode as the ramp speed. The ramp speed is set after the 
thermal cycling run is started. The “Select Method Options” screen appears. Select “Max” for 
the ramp speed, and enter the reaction volume (13 µL) 

 
NOTE:  The PCR amplification program will run for approximately 1.5 hours.  

 
2.5.6 Amplified DNA samples should be stored in the dark at -20 °C in a post-amp area. 

  
2.6 PowerPlex® Fusion System Amplification Procedure for Direct Amp (25 cycle half-volume reaction) 

 
2.6.1 Add 5.0 µL PunchSolution™ Reagent to each well of a 96-well plate that will contain a sample 

(including random sample and reagent blank). Do NOT add punch solution to wells that will ultimately 
contain the positive and negative amplification controls.  
 

2.6.2 Punch samples using either 1.2 mm Harris Micro-Punch® and cutting mat or BSD® semi-automated 
punch system. Add 1-3 sample punches to the designated well. 
 
NOTE: Weaker/difficult samples may require a higher number of punches to obtain a complete DNA 

profile. 
 
NOTE: If a 1.2 mm Harris Micro-Punch® is used to manually place the sample punch in the well (i.e. 

for cotton swatch blood samples), then a witness must be used for the transfer. 
 

2.6.3 After punching is completed, place the open plate into a 70°C heat block for 20 min. The sample wells 
should evaporate dry during this incubation. 
 
NOTE: If the plate is carried to a different room for the incubation, cover the plate with adhesive tape 

while transporting it. 
 

2.6.4 Calculate the required volume of each PCR amplification component to prepare a master mix by 
multiplying the volume by the number of samples. This should include a reagent blank, a random sample, 
positive and negative amplification controls and additional reaction volumes to compensate for any 
pipetting variation. The PCR Master Mix should be prepared in a clean 1.5 mL microcentrifuge tube. 

 
Half Reaction Master Mix, 12.5 µL total volume, consists of: 
 

2.5 µL PowerPlex® Fusion 5X Master Mix 
2.5 µL PowerPlex® Fusion 5X Primer Pair Mix 
2.5 µL 5X AmpSolution™ Reagent 
5.0 µL Amplification grade Water 

 
2.6.5 Prepare the sample DNA and controls as follows: 

 
2.6.5.1 Dried blood stains/buccal cells/random sample: Add 12.5 µL of master mix to the 

appropriately labeled sample tube or well containing the punch.  
 

2.6.5.2 Positive Amplification Control: Add 12.5 µL of master mix and 1.0 µL of the stock Control 
DNA to the appropriately labeled sample tube or well.  

 
2.6.5.3 Negative Amplification Control: Do not add any additional volume after master mix. 
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2.6.5.4 Reagent Blank: Do not add any additional volume after master mix. 
 

2.6.6 Place the 96 well amplification plate or tubes into the 9700 thermal cycler. Move the thermal cycler lid 
over the samples and tighten. 
 

2.6.7 Direct Amp: Amplification Parameters for the 9700 Thermal Cycler: 
 

2.6.7.1 96°C for 1 minute, then: 
 
94°C for 10 seconds 
59°C for 1 minute 
72°C for 30 seconds  
For 25 cycles, then: 
 
60°C for 20 minutes 
 
4°C soak 
 
The program must be run with Max mode as the ramp speed. The ramp speed is set after the 
thermal cycling run is started. The “Select Method Options” screen appears. Select “Max” for 
the ramp speed, and enter the reaction volume (13 µL) 
 
NOTE:  The PCR amplification program will run for approximately 1.5 hours.  

 
2.6.8 Amplified DNA samples should be stored in the dark at -20 °C in a post-amp area.
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3 CAPILLARY ELECTROPHORESIS 
 

3.1 Technical Notes 
 

3.1.1 The Applied Biosystems 3500xl Genetic Analyzer is a fluorescent capillary electrophoresis (CE) 
instrument with a 24 capillary array which can be used for DNA sequencing and fragment analysis 
applications. This includes STR (Short Tandem Repeat) analysis as well as DNA sequencing and SNP 
(Single Nucleotide Polymorphism) analysis. 

 
3.1.2 The capillary length and polymer type will vary based on the individual application. Sample handling 

and injection is automated by use of the autosampler, which holds two 96 well plates. 
 
3.1.3 The polymer delivery pump (PDP) automates the replenishment of polymer between injections so that 

the instrument is capable of fully-automated operation. 
 
3.1.4  Fluorescent detection is accomplished by utilizing single-line 505nm, solid-state long-life laser to excite 

fluorescent dyes and a CCD camera records the fluorescence emitted from samples within each of the 24 
capillaries. 

 
3.1.5 Data analysis including color separation is performed semi-automatically through the use of 

GeneMapper® ID-X software. 
 
3.1.6 For the purpose of this manual, the following definitions apply: 
 

3.1.6.1 Injection - all samples that were separated via CE at a single time. Thus, for one injection on 
the 3500xl, up to 24 samples can be separated at a single time. 

 
3.1.6.2 Run - all samples that were defined on a single plate and loaded onto the instrument at a 

single time for separation, regardless of the number of injections utilized to separate each 
sample contained on the plate. Thus, a run could contain up to 96 samples for separation on a 
single plate. 

  
3.2 Equipment 

 
• Applied Biosystems 3500xl Genetic Analyzer 
• 96-well plate centrifuge 
• Heat block, capable of 95 oC 
• Pipettes - 2 µL, 10 µL, 20 µL, 100 µL, 200 µL and/or 1000 µL 
• 8- Channel Pipette – Range 0.5 µL to 10 µL 

 
3.3 Materials 
 

• 36-cm capillary array (Applied Biosystems, Inc. P/N 4404687 (24-capillary)) 
• Optical 96-Well Reaction Plate (Applied Biosystems, Inc. P/N N8010560)  
• 96-well plate septum (Applied Biosystems, Inc. P/N 4315933) 
• 96-well plate retainer and base (Applied Biosystems, Inc. P/N 4409530) 
• Freezer block 
• Aerosol-resistant tips for pipettes – 10µL, 20µL, 100µL, 200µL, and 1000 µL  

 
3.4 Reagents 
 

• PowerPlex® 5-dye Matrix Standard 3100/3130 (Promega Corp. P/N DG4700) 
• Hi-Di Formamide (Applied Biosystems, Inc. P/N 4311320) 
• PowerPlex® Fusion Allelic Ladder (component of Fusion kit) 
• CC5 Internal Lane Standard (ILS) 500 Size Standard (component of Fusion kit) 
• POP-4 Polymer (Applied Biosystems, Inc. P/N 4393715 (384 samples) or P/N 4393710 (960 samples)) 
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• Anode buffer container (Applied Biosystems, Inc. P/N 4393925) 
• Cathode buffer container (Applied Biosystems, Inc. P/N 4408256) 
• Cathode buffer septa (Applied Biosystems, Inc. P/N 4410715) 

 
3.5 Safety Considerations 
 

3.5.1 The Applied Biosystems 3500/3500xl Genetic Analyzer uses single-line 505nm, solid-state laser. All 
instrument panels must be in place on the instrument while the instrument is operating. When all panels 
are installed, there is no detectable radiation present. If any panel is removed when the laser is operating, 
(during service with safety interlocks disabled) you may be exposed to laser emissions in excess of the 
Class 3B rating. Do not remove safety labels or disable safety interlocks. 

 
3.5.2 Performance Optimized Polymer (POP) is an irritant, always wear gloves when handling or cleaning 

liquid or dried polymer. It may cause skin, eye, and respiratory tract irritation. 
 

3.5.3 Exposure to Hi-Di Formamide causes eye, skin, and respiratory tract irritation. It is a possible 
developmental and birth defect hazard. Read the SDS, and follow the handling instructions. Wear 
appropriate protective eyewear, clothing, and nitrile gloves. 

 
3.6 Instrument Preparation 
 

3.6.1 Turn on the 3500xl instrument and the computer. The start-up order does not matter. 
 

3.6.2 The 3500xl instrument will go through an initialization process. 
 

3.6.3 On the computer, the Server Monitor/Daemon will launch automatically. The Server Monitor is 
completely loaded when the green check mark appears in the lower right corner of the screen. 

 
3.6.4 After the Server Monitor/Daemon is fully loaded and there is a green light on the front of the 3500xl 

instrument, the 3500 Series Data Collection Software may be opened. 
 

3.6.5  The Dashboard screen will launch (Figure 1). 
 

 
 

Figure 1. The dashboard 
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3.6.6 Ensure the oven temperature is set to 60°C, and then select “Start Pre-Heat” at least 30 minutes prior to 
the first injection to preheat the oven. 

 
3.6.7 Click “Refresh” in the “Consumables Information” window. The readings/gauges will be updated once 

the RFID tags are read.  
 

3.6.7.1 Anode and cathode buffer containers will need to be changed if they have been on the 
instrument longer than fourteen days. See Appendix C for additional information regarding 
changing either buffer. 

 
3.6.7.2 Verify that enough polymer remains in the pouch (# of samples remaining / # injections 

remaining). Also verify that the polymer has not been on the instrument longer than 14 days 
and that it has not expired. If the polymer is old, expired or an insufficient number remains, 
the polymer pouch will need to be changed prior to starting the run. See “Replenish polymer” 
in Appendix C for additional information. 

 
3.6.8 Check the 3500xl instrument and perform the daily/pre-run tasks below. 

 
TASK FREQUENCY FOR MORE INFORMATION 

Visually inspect the level of fluid inside the ABC and the 
CBC. The fluid must line up with the fill line. 
 

Before each run Appendix C – changing ABC or 
CBC 

Ensure that the plate assemblies are properly assembled. 
 
IMPORTANT! Align the holes in the plate retainer with 
the holes in the septa to avoid damaging capillary tips. 
 

Before each run See section 3.7.2 and 3.7.3 

Ensure that the plate assemblies and the CBC and septa are 
positioned on the plate deck properly. They should sit 
securely on the deck. 
 

Before each run  
 
 
 

Check for bubbles in the pump block and channels. 
 
Note: Use the Remove Bubble wizard to remove bubbles.  
 

Daily or before 
each run 

Appendix C – bubble remove 
wizard 

Check the loading-end header to ensure that the capillary 
tips are not crushed or damaged. If crushed or damaged, 
the capillary array will need to be changed. 
 

Daily or before 
each run 

Appendix C – Change the 
Capillary Array 

Clean the instrument surfaces of dried residue, spilled 
buffer, or dirt. 
 

Daily  
 
 

Check for leaks and dried residue around the Buffer-Pin 
Valve, check valve, and array locking lever. If leaks 
persist, contact AB. 
 

Daily  

 
3.7 Sample Preparation 
 

3.7.1 To prepare a convicted offender/arrestee sample plate, prepare a ‘master mix’ of formamide and size 
standard as follows: 

 
3.7.1.1 Thaw the CC5 ILS 500 and Hi-Di formamide. Vortex both briefly to mix. 

 
3.7.1.2 Prepare a loading cocktail by combining and mixing CC5 ILS and Hi-Di formamide as 

follows: 
 

[(1.0ul CC5 ILS 500) X (# samples)] + [(10.0ul Hi-Di formamide) X (# samples)] 
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NOTE: Be sure to add extra samples to account for pipetting variation which will vary 
depending on the number of samples. For example, if preparing an entire plate of 
samples (96), preparation of the master mix for approximately 106 samples is 
appropriate. 

 
3.7.1.3 Vortex this ‘master mix’ to ensure the contents are thoroughly mixed. 

 
3.7.1.4 Pipet 11 µL of the ‘master mix’ into each used well of the 96-well plate.  

 
3.7.1.5 10 µL of Hi-Di formamide or extra ‘master mix’ should be pipetted into unused wells of the 

plate that will be injected to ensure that air is not injected into some of the capillaries. (That 
is, if one injection (24 samples total) will be completed on the 24-capillary 3500xl, it is 
necessary to ensure that all sample wells in all three columns contain liquid.) 

 
3.7.1.6 Place the plate septum on top of the sample wells and use a scalpel to cut the septum into 

single column strips. During the amplified DNA transfer, only one column of both the CE 
plate as well as the amplification plate should be open at a time. Pipet PCR product (for 
samples, positive controls, and negative controls) into the corresponding well of the 96-well 
plate. Typically, 1 µL of PCR product will be added. However, 0.5 µL or 2 µL of the PCR 
product may be used at the analyst’s discretion and will be noted on the technical 
documentation. 

 
NOTE: The same volume of PCR product (or more) used for the samples must also be used 

for the negative control(s) and reagent blank(s).  
 

3.7.1.7 Pipet 1 µL of allelic ladder into at least two wells per plate. 
 

3.7.1.8 Cover wells with appropriate septa. 
 

3.7.1.9 Centrifuge the plate briefly to remove air bubbles from all wells. 
 

3.7.1.10 Just prior to loading the instrument, denature samples at 95 oC for 2 minutes, then 
immediately chill in a freezer block for 2 minutes. 

 
3.7.2 Place the denatured and chilled plate into a blue plate base and snap the white plate retainer over the top 

taking care to align the tabs on both ends.  
 

3.7.3 Press the tray button on the 3500xl to bring the autosampler tray forward. Open the instrument door and 
place the plate assembly into an open position (A or B) with the labeled end of the white plate retainer 
facing you. 

 
3.7.4 Close the instrument door.  

 
3.8 Instrument Operation 

 
3.8.1 Importing a plate file 

 
3.8.1.1 Click on “Library>plates” in the navigation pane. 

 
3.8.1.2 Click “Import”. Use the drop down menu to select “*.xls”. Browse to find the selected run 

file. Double click to import the correct file. Click “OK” after verifying the correct file was 
imported. 

 
3.8.1.3 Open the imported file. Verify the information is correct and proceed to 3.8.3, “Linking plate 

for run”. 
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3.8.2 Manually entering a plate file 
 

3.8.2.1 Sample information may also be entered manually. In the Dashboard, click “Create New 
Plate” and enter the plate details. 

 
• Enter the plate name 
• Number of wells: 96 
• Plate Type: HID 
• Capillary Length: 36 cm 
• Polymer: POP4 
• Owner initials 

 
3.8.2.1.1 Click on “Assign Plate Contents” 

 
3.8.2.1.2 Using either the “Plate View” or “Table View”, enter the sample names in the 

appropriate well. 
 

3.8.2.1.3 Under “Assays” click “Add from Library”. Select the appropriate file from the 
list and close the window. Data bank samples will be run with 
“PP_Fusion_24sec” and/or “PP_Fusion_12sec” or 
“PP_Fusion_24sec_AND_12sec”. 

 
3.8.2.1.4 Under “File Name Conventions” click “Add from Library”. Select “Databank” 

from the list and close the window. 
 

3.8.2.1.5 Under “Results Groups” click “Add from Library”. Select “Databank” from the 
list and close the window. 

 
3.8.2.1.6 Highlight all samples to be run and click the check box in “Assays”, “File Name 

Conventions” and “Results Groups”. 
 

3.8.2.1.7 In “Table View”, use the drop down under “Sample Type” to designate the 
Negative Control, Positive Control and Allelic Ladders. All other samples 
should remain “Sample”. 

 
3.8.2.1.8 In the “UD2” (user defined comment) field, add the appropriate letters to 

indicate the specimen category. 
 

3.8.2.1.9 Save the plate file and proceed to Section 3.8.3 “Linking Plate for Run”. 
 

3.8.3 Linking plate for run 
 

3.8.3.1 Click “Load Plates for Run” in the navigation pane. 
 

3.8.3.2 Plates must be loaded onto the autosampler tray before it may be linked for a run. Click “Link 
Plate” in the appropriate position (A or B). Browse in the pop-up window to find the 
appropriate plate file. Double click on plate name to select, and then close the window. 

 
3.8.3.3 Click “Start Run”. The instrument will notify you at this time if there is any instrument or 

reagent issue with the requested run. If an issue is detected, the run will not begin until the 
issue is resolved. 

 
3.8.3.4 Alternatively, you may click “Create injection list”. Preview the injection list and move 

selected injections up or down to change the injection order. Once the order is determined, 
click “Start Run”. The injection order may also be changed once the run has begun with the 
exception of the first injection (which is running). 
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3.8.3.5 Following completion of the run, proceed to Chapter 4 for data analysis and interpretation. 
 

3.8.4 Re-injections 
 

3.8.4.1 Re-injections may be designated in two ways and are outlined below. 
 

NOTE: The same injection time or longer than that used for the samples must be used for the 
negative controls and reagent blanks. 

 
3.8.4.2  Re-injections may be designated on a plate while the plate is running on the instrument. After 

the run has started, in the “Monitor Run” screen, highlight the desired wells or select the 
desired injection to designate for re-injection.  

 
3.8.4.2.1 To collect data for all wells in an injection, select the injection in the injection 

list. Click the “Re-inject” button. 
 

3.8.4.2.2 To collect data for only specific wells, select the injection. Then select in the 
array view the capillary that corresponds to the well or sample of interest. Click 
the “Re-inject” button. 

 
3.8.4.2.3 In the re-injection dialog box, select options, then click OK. 

 
• The protocol to use for the re-injection: original, modified, new, or one 

from the library. 
• When to make the injection. 

 
3.8.4.2.4 If you select to re-inject a sample that includes an allelic ladder in its results 

group, but the allelic ladder is not part of the injection, the software prompts you 
to select one or more allelic ladder samples to re-inject. 

 
3.8.4.2.5 In the “Add Allelic Ladder to Re-injection” screen, select one or more allelic 

ladder samples and then select whether to collect data for the remaining samples 
in the allelic ladder re-injection. 

 
3.8.4.2.6 Then select whether to apply a modified instrument protocol to the allelic ladder 

re-injections, or whether to use the original instrument protocol for the allelic 
ladder re-injection(s). You will select the modified protocol in the next screen. 

 
3.8.4.2.7 The injections will be designated on each well of the plate. Review for accuracy 

and change if necessary. 
 

3.8.4.3 Alternatively, the plate file may be re-created using a different name. Typically re-injection 
files are named by appending “R” to the end of the plate file name. Select the “Assay” that 
designates the desired injection time.  

 
3.8.4.3.1 If this option is chosen, the plate will need to be linked and run after the original 

plate run is completed. 
 

3.8.4.4 To pause a run, click “pause” and the run will pause after the current injection completes. 
 

3.8.4.4.1 “Resume” will resume the run. 
 

3.8.4.5 To abort a run, click “abort” and the current injection immediately aborts and pauses the 
instrument run. You can resume the run or terminate the injection list. Do not click Delete to 
stop an injection. 
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3.8.4.6 To terminate an injection list, click “terminate injection list” and the instrument run will stop. 
Terminate is only active after you click “pause” or “abort”. 

 
3.8.4.7 Following completion of the run, proceed to Chapter 4 for data analysis and interpretation.
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4 ANALYSIS AND INTERPRETATION OF POWERPLEX® FUSION SYSTEM CE DATA 
 
4.1 Technical Notes 
 

4.1.1 The PowerPlex® Fusion System is a 24-locus multiplex for human identification applications including 
forensic analysis, relationship testing and research use. This five-color system allows co-amplification 
and fluorescent detection of the 13 core CODIS (US) loci (CSF1PO, FGA, TH01, TPOX, vWA, 
D3S1358, D5S818, D7S820, D8S1179, D13S317, D16S539, D18S51 and D21S11), the 12 core 
European Standard Set (ESS) loci (TH01, vWA, FGA, D21S11, D3S1358, D8S1179, D18S51, 
D10S1248, D22S1045, D2S441, D1S1656 and D12S391) and Amelogenin for gender determination. In 
addition, the male-specific DYS391 locus is included to identify null Y allele results for Amelogenin. 
The Penta D and Penta E loci are included to increase discrimination and allow searching of databases 
that include profiles with these Penta loci. Finally, the D2S1338 and D19S433 loci, which are popular 
loci included in a number of databases, were incorporated to further increase the power of discrimination. 
This extended panel of STR markers is intended to satisfy both CODIS and ESS recommendations. 1 

 
4.1.2 The CC5 ILS 500 consists of 21 DNA fragments (60, 65, 80,100, 120, 140, 160, 180, 200, 225, 250, 275, 

300, 325, 350, 375, 400, 425, 450, 475, and 500 bp). 
 

4.1.3 GeneMapper® ID-X (GMIDx) is an automated genotyping software program for all human identification 
(HID) data analysis needs, including forensic casework, databasing, and paternity testing. GMIDx 
software provides information on peak quality (height, base pair size, shape, number) as well as 
designating alleles. 

 
4.1.4 The raw data obtained with the Applied Biosystems 3130xl and 3500xl Genetic Analyzers can be 

analyzed using GeneMapper® ID-X software.  
 

4.1.5 Table 1 shows the PowerPlex® Fusion System STR Loci, Label, Chromosomal Location, and Repeat 
Sequence 

STR Locus Label Chromosomal Location2 Repeat Sequence3 
5´→3´ 

Amelogenin4 Fluorescein Xp22.1–22.3 and Y NA 

D3S1358 Fluorescein 3p21.31 (45.557Mb) TCTA Complex 

D1S1656 Fluorescein 1q42 (228.972Mb) TAGA Complex 

D2S441 Fluorescein 2p14 (68.214Mb) TCTA 

D10S1248 Fluorescein 10q26.3 (130.567Mb) GGAA 

D13S317 Fluorescein 13q31.1 (81.62Mb) TATC 

Penta E Fluorescein 15q26.2 (95.175Mb) AAAGA 

D16S539 JOE 16q24.1 (84.944Mb) GATA 

D18S51 JOE 18q21.33 (59.1Mb) AGAA (19) 

D2S1338 JOE 2q35 (218.705Mb) TGCC/TTCC 

CSF1PO JOE 5q33.1 (149.436Mb) AGAT 

Penta D JOE 21q22.3 (43.88Mb) AAAGA 

TH01 TMR-ET 11p15.5 (2.149Mb) AATG (19) 

vWA TMR-ET 12p13.31 (5.963Mb) TCTA Complex (19) 

D21S11 TMR-ET 21q21.1 (19.476Mb) TCTA Complex (19) 

D7S820 TMR-ET 7q21.11 (83.433Mb) GATA 

D5S818 TMR-ET 5q23.2 (123.139Mb) AGAT 

TPOX TMR-ET 2p25.3 (1.472Mb) AATG 

DYS391 TMR-ET Y TCTA 

D8S1179 CXR-ET 8q24.13 (125.976Mb) TCTA Complex (19) 

D12S391 CXR-ET 12p12 (12.341Mb) AGAT/AGAC Complex 
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D19S433 CXR-ET 19q12 (35.109Mb) AAGG Complex 

FGA CXR-ET 4q28 (155.866Mb) TTTC Complex (19) 

D22S1045 CXR-ET 22q12.3 (35.779Mb) ATT 
 

Table 1. The PowerPlex® Fusion System STR Loci, Label, 
Chromosomal Location, and Repeat Sequence 

 

2 Information about the chromosomal location of these loci can be found in references 20, 21 and 22 and at: 
www.cstl.nist.gov/biotech/strbase/chrom.htm 

3 The August 1997 report of the DNA Commission of the International Society for Forensic Haemogenetics (ISFH) states, “1) for 
STR loci within coding genes, the coding strand shall be used and the repeat sequence motif defined using the first possible 5´ 
nucleotide of a repeat motif; and 2) for STR loci not associated with a coding gene, the first database entry or original literature 
description shall be used”. 

4 Amelogenin is not an STR but displays an 89-base, X-specific band and a 95-base, Y-specific band. 
 
Table from Promega’s PowerPlex® Fusion System Technical Manual, revision 10/12 

 
4.2 Logging On 
 

4.2.1 Open the GeneMapper® ID-X (GMIDx) software by double-clicking on the software icon.  
 

4.2.2 Select the appropriate user name and type the password. Click OK. 
 
4.3 Project Window 
 

4.3.1 Upon opening the software, the user is taken to the Project Window, as shown in Figure 1. 
 

 
 

Figure 1. Project Window 
 

4.3.2 To begin the data analysis, samples must be added to the project to be analyzed. 
 

NOTE: All samples to be analyzed from a single run should be added at once. If not done in this 
manner, the GMIDx software may not associate the correct allelic ladders with the given 
samples.  

 
4.3.2.1 Choose “Edit” and “Add samples to Project”  

 
4.3.2.2 Browse to the data files to analyze. You may select the entire folder or pick the files within 

the folder to analyze. 
 

4.3.2.3 Click “Add to List” (bottom left of screen) then “Add” (bottom right of screen).  
 

4.3.3 Upon addition of the samples to the project, the “Samples” tab will become populated, as shown in 
Figure 2. The population of the information is based on that entered in the Plate Map in the 3500xl Data 
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Collection Software. Double check to ensure that the correct panel, sample type, and analysis method are 
selected. If changes need to be made to this information, select the necessary cells and choose the 
appropriate settings from the drop-down menus. Verify that the information is correct before proceeding.  

 

  
 

Figure 2. “Samples” tab upon adding samples to the newly created project 
 

4.3.3.1 Analysis Method = “PPFusion_DB”. 
 

4.3.3.2 Panel = “PowerPlex_Fusion_Panels_IDX_v1.0”. 
 

4.3.3.3 Size Standard = “CC5_ILS_500_IDX” 
 

4.3.4 Each data file has an               icon in the Status column indicating that it needs to be analyzed. 
 

4.3.5 In the tree pane view on the left side of the screen, choose the file name of a negative control. Choose 
View>Raw Data to view the unseparated raw fluorescence data.  

 
4.3.6 The recognizable pattern of the size standard should appear in orange. The raw data may be used to 

evaluate baseline problems or noise that could result in poor sizing. In addition, the start and stop points 
for the analysis should be noted. The start and stop points should be such that all size standards are 
encompassed by the data points analyzed. Typically, this is approximately 3,000 – 10,000 data points, 
but may need to be modified on a per-run basis, if, for example, at the 10,000 end point, the 500 bp size 
standard is missing. Extending the range beyond 10,000 will include the missing 500 bp fragment. This 
start and stop point may be edited in the Analysis Method Editor, as described below. 
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4.3.7 Exit from the Negative Control raw data, and select Tools>Analysis Method Editor  
 

4.3.7.1 Click on the “Peak Detector” tab. The Peak Detector tab is where the values such as dye 
specific detection thresholds and analysis start and stop points are set (Figure 3). 

 

 
 

Figure 3. The Peak Detector Tab window 
 

4.3.7.2 Change the analysis range to the start and stop points defined in 4.3.6, if necessary. 
 

4.3.7.3 The values for the peak amplitude thresholds are based upon empirical data derived from the 
limit of detection analysis performed during the validation work and are averaged for both 
Data Bank 3500xl instruments. While the CC5 ILS 500 (which uses the orange dye) will have 
its default peak amplitude threshold set based on the LOD analysis, the threshold may be 
reduced when the ILS 500 peaks may fall below the default threshold (this can occasionally 
occur with the 12 second injection). It is important to note that ONLY the orange dye (CC5 
ILS 500 size standard) may be adjusted if such conditions are present. 

 
4.3.7.4 Smoothing should be set to “light” and the size calling method should be set to Local 

Southern Method. 
 
Note: Sizing of Penta E and DYS391 alleles ≥475 bases will not use Local Southern Method. 

For Penta E, alleles >24 will be labeled as “OL.”1 

 
4.3.8 The Genotypes tab of the project window can display a number of additional “flags” to indicate the 

quality of the data. These may be used, at the analyst’s discretion, to aid in interpretation of the data. 
Refer to The GeneMapper® ID-X Software User’s Guide or the “Help” section in the software (Analysis 
Requirement Flags, Process Quality Value (PQV) Flags, and Data Review Flags) for an explanation of 
the usage of each flag.  
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4.3.9 Analyze the samples by clicking the green arrow:            (Analyze). Upon prompting, type a name for the 
project. Click OK. 

 
4.4 Examining Internal Lane Standard Results 
 

4.4.1 The analysis run will finish and display the “Analysis Summary” screen which assesses run data 
according to Quality flag settings. Click on the “Samples” tab to view sample data. Assess the run by 
first examining the flags in the SQ (sizing quality) column. A green square indicates that a sample has 
passed the sizing criteria. For any samples that do not pass the sizing criteria, indicated by a yellow 
triangle or red octagon, assess the size standard by highlighting the samples and click on the icon: 
or selecting Tools>Size Match Editor. 

 
NOTE: If the majority of the size standards fail, look for a global problem with the run, such as a 

poorly-chosen sizing range in the Analysis Method Editor. 
 

4.4.2 If the sizing standard is observed in the sample, check to see that all peaks are detected and the peaks are 
labeled correctly. The peaks should follow the pattern shown in Figure 4.  
 

 
 

Figure 4. CC5 ILS 500 Size standard. The peaks are labeled with their base pair size. 
 

4.4.3 The sizing quality of the sample is shown directly above the labeled size match electropherogram, as 
shown in Figure 4. Typically, a low sizing quality value (e.g., 0.5) is a result of a peak shift (the software 
incorrectly identifies one peak resulting in invalid positions for the other size standard peaks), a missing 
peak (the software does not identify a peak), or an extra peak (the software identifies a peak that is not a 
size standard peak, but a spike or pull-up peak. 

 
4.4.3.1 If the size standard peak assignments are incorrect, adjust the peak assignments within the 

size match editor. To edit a particular size standard peak, right-click the peak to be edited to 
open the editing pop-up window and select “Add”, “Delete” or “Change” the selected peak. 
Move the cursor to the right to open the “Select Size” sub-menu. Choose the desired size from 
the menu. 

 
4.4.3.2 When the peaks are sized properly, check the sizing quality by selecting Tools>Check Sizing 

Quality. If the peaks are sized correctly, the quality value will improve. If the peaks are sized 
correctly but the quality score is still below passing, click the “Override SQ” button, as shown 
in Figure 4, to set the sizing quality to 1.0. Note that the sizing quality will now read <1.0> 
and a blue “X” will appear in the Sample tab under the SQO (Sizing Quality Override) 
column to indicate the sizing quality has been overridden by the analyst. Alternatively, the 
sample may be re-injected at the analyst’s discretion. 
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4.5 Examining Allelic Ladder Results 
 

4.5.1 In the “Samples” tab, select each allelic ladder. Display the plots by clicking the sample plots icon: 
 

4.5.2 Verify that the allelic ladder is called correctly for each locus. Figure 5 represents an example of a 
PowerPlex® Fusion allelic ladder. Allelic ladder information is also contained in Table 2. 

 

 
 

Figure 5. PowerPlex® Fusion Allelic Ladder 
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STR Locus Label 
Size Range of Allelic Ladder 

Components 5,6 (bases) 
Repeat Numbers of Allelic Ladder 

Components7 

Amelogenin8 Fluorescein 89, 95 X, Y 
D3S1358 Fluorescein 103–147 9–20 
D1S1656 Fluorescein 

161–208 
9–14, 14.3, 15, 15.3, 16, 16.3, 17, 17.3, 

18, 18.3, 19, 19.3, 20.3 
D2S441 Fluorescein 214–250 8–11, 11.3, 12–17 
D10S1248 Fluorescein 256–280 8–19 
D13S317 Fluorescein 302–350 5–17 
Penta E Fluorescein 371–466 5–24 
D16S539 JOE 84–132 4–16 
D18S51 JOE 134–214 7–10, 10.2, 11–13, 13.2, 14–27 
D2S1338 JOE 224–296 10, 12, 14–28 
CSF1PO JOE 318–362 5–16 
Penta D JOE 377–450 2.2, 3.2, 5–17 
TH01 TMR-ET 72–115 3–9, 9.3, 10–11, 13.3 
vWA TMR-ET 127–183 10–24 
D21S11 TMR-ET 

203–259 
24, 24.2, 25, 25.2, 26–28, 28.2, 29, 29.2, 
30, 30.2, 31, 31.2, 32, 32.2, 33, 33.2, 34, 

34.2, 35, 35.2, 36–38 
D7S820 TMR-ET 269–313 5–16 
D5S818 TMR-ET 321–369 6–18 
TPOX TMR-ET 393–441 4–16 
DYS391 TMR-ET 442–486 5–16 
D8S1179 CXR-ET 76–124 7–19 
D12S391 CXR-ET 133–185 14–17, 17.3, 18, 18.3, 19–27 
D19S433 CXR-ET 

193–245 
5.2, 6.2, 8–12, 12.2, 13, 13.2, 14, 14.2, 15, 

15.2, 16, 16.2, 17, 17.2, 18, 18.2 
FGA CXR-ET 

265–411 
14–18, 18.2, 19, 19.2, 20, 20.2, 21, 21.2, 22, 

22.2, 23, 23.2, 24, 24.2, 25, 25.2, 26–30, 31.2, 
32.2, 33.2, 42.2, 43.2, 44.2, 45.2, 46.2, 48.2, 50.2 

D22S1045 CXR-ET 425–464 7–20 
 
5 The length of each allele in the allelic ladder has been confirmed by sequence analysis. 
6 When using an internal lane standard, such as the CC5 Internal Lane Standard 500, the calculated sizes of allelic ladder 

components may differ from those listed. This occurs because different sequences in allelic ladder and ILS components may cause 
differences in migration. The dye label and linker also affect migration of alleles. 

7 For a current list of microvariants, see the Variant Allele Report published at the U.S. National Institute of Standards and 
Technology (NIST) web site at: www.cstl.nist.gov/div831/strbase/ 

8 Amelogenin is not an STR but displays an 89-base, X-specific band and a 95-base, Y-specific band. 
 
Table taken from Promega’s PowerPlex® Fusion System Technical Manual, revision 10/12 
 

Table 2. The PowerPlex® Fusion System Allelic Ladder Information 
 

4.6 Examining the Reagent Blank 
 

4.6.1 The reagent blank should be checked to ensure that no amplification product (called alleles) was 
observed. A called allele is a peak which fits the criteria to be designated an allele or OL (off ladder) and 
is above the allele calling threshold designated in the software and therefore is labeled. 

 
4.6.1.1 If a signal (peak) is detected in the reagent blank at a single locus, the test results associated 

with the reagent blank will be evaluated against the samples around it to determine whether 
the result can be used.  
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4.6.1.1.1 If the reagent blank will be used as is, the Forensic Biology Program Manager or 
designee must grant approval. Documentation of this approval will be stored in 
the file.  

 
4.6.1.1.2 Alternatively, if the reagent blank is re-injected or re-prepared and the result 

does not reproduce the signal (peak), the reagent blank result can be used 
without subsequent approval. The original sample injections can be analyzed if 
the reagent blank is clean upon re-injection. 

 
4.6.1.1.3 If neither option above is utilized, then the reagent blank and all associated 

samples must be re-extracted and/or re-amplified. 
 

4.6.1.2 If a signal (peak) is detected in the reagent blank at multiple loci, the test results for all loci 
will be considered inconclusive and all samples will be re-extracted and/or re-amplified. 

 
4.6.2 For a typing result to be reported, the reagent blank must have been treated appropriately (i.e., same or 

longer injection times and same or larger volumes loaded into the injection cocktail). 
 
4.7 Examining the Negative Amplification Control 
 

4.7.1 The negative amplification control should be checked to ensure that no amplification product (called 
alleles) was observed. A called allele is a peak which fits the criteria to be designated an allele or OL (off 
ladder) and is above the allele calling threshold designated in the software and therefore is labeled. 

 
4.7.1.1 If a signal (peak) is detected in the negative amplification control at a single locus, the test 

results associated with the negative amplification control will be evaluated against the 
samples around it to determine whether the result can be used.  

 
4.7.1.1.1 If the negative amplification control will be used as is, the Forensic Biology 

Program Manager or designee must grant approval. Documentation of this 
approval will be stored in the file.  

 
4.7.1.1.2 Alternatively, if the negative amplification control is re-injected or re-prepared 

and the result does not reproduce the signal (peak), the negative amplification 
control result can be used without subsequent approval. The original sample 
injections can be analyzed if the negative amplification control is clean upon re-
injection. 

 
4.7.1.1.3 If neither option above is utilized, then the negative and all associated samples 

must be re-amplified. 
 

4.7.1.2 If a signal (peak) is detected in the negative amplification control at multiple loci, the test 
results for all loci will be considered inconclusive and all samples will be re-amplified. 

 
4.7.2 For a typing result to be reported, the negative control must have been treated appropriately (i.e., same or 

longer injection times and same or larger volumes loaded into the injection cocktail). 
 
4.8 Examining the Positive Amplification Control 
 

4.8.1 If the positive control has injected poorly, it can be re-injected or if necessary, re-prepared and injected. 
The original sample injections can be analyzed if the correct types for the positive control are 
documented upon the re-injection or re-run.  
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4.8.2 The positive amplification control DNA must elicit the "known" genotype for each locus (see Table 3). If 
an allele is detected in the positive control DNA at a specific locus that is not consistent with the known 
genotype or no result is obtained at any locus, the samples will be re-amplified. 
 
 

Locus Genotype 2800M 
Amelogenin X,Y 

D3S1358 17,18 
D1S1656 12,13 
D2S441 10,14 

D10S1248 13,15 
D13S317 9,11 
Penta E 7,14 

D16S539 9,13 
D18S51 16,18 

D2S1338 22,25 
CSF1PO 12,12 
Penta D 12,13 
TH01 6,9.3 
vWA 16,19 

D21S11 29,31.2 
D7S820 8,11 
D5S818 12,12 
TPOX 11,11 

DYS391 10 
D8S1179 14,15 
D12S391 18,23 
D19S433 13,14 

FGA 20,23 
D22S1045 16,16 

 
Table 3. 2800M PowerPlex® Fusion profile 

 
4.9 Examining the Random Sample 
 

4.9.1 The Random Sample profile, when searched in CODIS, must elicit the correct result. If the DNA sample 
number identified as a result of the search is different from the DNA sample number on the master list 
(maintained by the Forensic Biology Program Manager or designee) and is not a duplicate, all samples 
associated with the Random Sample will be re-extracted and/or re-amplified. 

 
4.9.2 If the Random Sample has injected poorly, it can be re-injected or if necessary, re-prepared and injected. 

The original sample injections can be analyzed if the correct types for the Random Sample are 
documented upon the re-injection or re-run. 

 
4.9.3 If no typing result is observed for the Random Sample (for convicted offender and arrestee sample 

analysis), all samples will be re-extracted and/or re-amplified. 
 
4.10 Examining Data Bank Samples 
 

4.10.1 If it is determined that a sample contains stutter peaks at a majority of the loci and other artifactual peaks 
are visible throughout the electropherogram due to injecting too much and/or amplifying too much 
sample DNA, the sample may be re-injected using a reduced injection time and/or using less amplified 
DNA in the injection cocktail. Samples may also be re-amplified with less template DNA and then re-
typed. If, however, the accurate profile can be determined from the original sample profile by both the 
analyst and the independent technical reviewer, then the data may be used. 
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4.10.2 All sample data must be reviewed carefully, with special attention paid to samples that display a yellow 
triangle or red octagon, indicating low quality analysis data. 

 
4.10.2.1 A green square indicates that the data passed the initial (automated) analysis by the software 

in the respective category (such as sizing quality, off-scale data, etc.). 
 

4.10.2.2 If a flag is yellow or red, it may be helpful to look at the raw data to determine the problem. 
To look at the raw data from the samples tab, highlight the sample and select View>Raw 
Data.  

 
4.10.2.3 If it is determined that the sample should not be considered for interpretation due to problems 

within the raw data, the sample may be re-injected or run again using a different amplification 
reaction, more PCR product, less PCR product, or other necessary procedures. 

 
4.10.2.4 If the sizing quality for a given sample is low, the sample will not be genotyped by the 

software. 
 

4.10.3 Convicted offender and arrestee samples are expected to exhibit single source profiles. If more than one 
DNA profile is seen in a single sample, the sample will be re-extracted and/or re-amplified. 

 
4.10.4 An independent electronic review must be performed for each sample and will be conducted by the 

technical reviewer using the GMIDx software. 
 
4.11 Identifying Amplification Artifacts 

 
4.11.1 Since convicted offender and arrestee samples are not quantified prior to amplification, the 

overamplification of some samples will happen. When an excess of DNA is added to the amplification 
cocktail, artifacts may occur. Most of these artifacts will be below the 20% global filter cut-off used for 
convicted offender and arrestee samples and will not be labeled by the software. Application of the 
global filter causes all peaks below 20% of the highest peak within each marker not to be labeled. Figure 
6 shows the settings contained in the “Allele” tab of the Analysis Method Editor. 

 

 
 

Figure 6. “Allele” tab of the Analysis Method Editor showing Global filter settings 
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4.11.1.1 For analysis of sample data, all electropherograms must be visually evaluated by the analyst 
to ensure that artifacts are not mislabeled. If a peak is mislabeled (e.g., stutter, spike, pull-up, 
etc.), the allele call can be electronically edited by the analyst. 
 
4.11.1.1.1 To electronically edit the allele call of a mislabeled peak, select the peak of 

interest by right-clicking on it. 
 

4.11.1.1.2 If the peak is already labeled, the allele call can be deleted. The user will be 
prompted to add a comment which will be maintained in the audit trail for the 
sample in GMIDx. For Data Bank convicted offender and arrestee samples, all 
deleted peaks will be considered to be “ART” and the display of the allele edit 
comment in the plot setting is not necessary. 
 

4.11.1.2 If an analyst believes that a peak is real and the software does not label the peak due to the 
filter applied, the analyst may remove the filter and reanalyze the sample to better evaluate the 
peak in question.  
 

4.11.2 Off-scale data and Pull-up 
 

4.11.2.1 Fluorescence intensity that exceeds the linear dynamic range for detection by the instrument is 
labeled "off-scale" data. Quantitation (peak height and area) for off-scale peaks is not 
accurate. An allele peak that is off-scale can cause the corresponding stutter peak to appear 
higher in relative intensity, thus increasing the calculated percent stutter. 

 
4.11.2.2 Pull-up refers to peaks that are not true alleles but result from poor color separation of the raw 

data or off-scale data in one or more channels. Refer to Figure 7 for an example of pull-up at 
the D3S1358 locus.  

 

 
Figure 7. Pull-up from the green channel (JOE) into the blue channel (FL), indicated by the red circle 

and shown as an edited “11” peak that has been deleted to indicate pull-up (artifact). 
 

4.11.2.3 Recurrent pull-up due to poor color separation in samples indicates the need to complete a 
new spectral calibration. 

 
 

COPYRIGHT © 20 16 

VIRGINIA 
DEPARTMENT 

OF 
FORENSIC SCIENCE 

UNCONTROLLED 
COPY 



4 Analysis and Interpretation of Powerplex® Fusion System CE Data 
 

Data Bank PowerPlex® Fusion Procedures Manual DFS Document 211-D450 
Issued by Biology Program Manager Revision 1 
Issue Date: 28-March-2016 Page 28 of 56 

4.11.3 Incomplete +A nucleotide addition 
 

4.11.3.1 Terminal nucleotide addition occurs when the thermostable non-proofreading Taq DNA 
polymerase adds a nucleotide, generally adenine, to the 3´ ends of amplified DNA fragments 
in a template-independent manner. 1 Modified primer sequences and the addition of a final 
extension step at 60°C to the amplification protocol are done to drive conditions to essentially 
complete terminal nucleotide addition when recommended amounts of template DNA are 
used. Excessive input DNA makes the adenine addition less efficient and thus PCR fragments 
shorter by one nucleotide than the amplicon size may appear (-A). Typically, these artifacts 
appear as a downstream shoulder on a peak. 

 
4.11.4 Stutter 

 
4.11.4.1 Repeat slippage, sometimes called “stutter” or “shadow bands”, is due to the loss of a repeat 

unit during DNA amplification, somatic variation within the DNA, or both.1 Stutter peaks 
frequently appear during PowerPlex® Fusion System profiling. These are most commonly 4 
nucleotides smaller than the amplicon size (true peak) for the tetranucleotide repeats, 3 
nucleotides smaller for the trinucleotide repeats and 5 nucleotides smaller for the 
pentanucleotide repeats.  

 
4.11.4.2 Stutter is typically more pronounced when excessive quantities of DNA are placed into the 

amplification cocktail. Stutter may also appear as multiples of the repeat unit (e.g. 8 
nucleotides) or may be larger than the amplicon size (+4 stutter or “up-stutter”).  

 
NOTE: Frequently, alleles with a greater number of repeat units will exhibit a higher percent 

stutter. A trinucleotide repeat locus, like D22S1045, will have more pronounced 
stutter in both n–3 and n+3 positions than a typical tetranucleotide repeat locus. The 
pattern and intensity of stutter may differ slightly between primer sets for the same 
loci. 1 

 
4.11.4.3 The GMIDx software is programmed to detect (i.e. not call as an allele) stutter peaks that are 

less than 20% of the largest peak at each locus. 
 

4.11.4.3.1 If the ratio of the peak height for the smaller peak to the larger peak is less than 
20%, the allele will be considered to be stutter by GMIDx and no allele will be 
designated even if it is suspected that the peak is a true allele. 
 

4.11.4.3.2 If the ratio of the peak height for the smaller peak to the larger peak is above 
20% (this event is generally observed in samples containing a high 
concentration of DNA or the DNA is partially degraded), the allele may still be 
called stutter once all loci have been taken into account and both the analyst and 
the independent technical reviewer are in agreement (based upon knowledge of 
the system and experience) that the smaller peak is stutter. 

 
4.11.5 Spikes 

 
4.11.5.1 Spikes are CE-related artifacts in which minor voltage changes or urea crystals passing by the 

laser can cause “spikes” or unexpected peaks. Spikes sometimes appear in one channel but 
often are easily identified by their presence in more than one channel.1 

 
4.11.5.2 Signal spikes can frequently resemble peaks, but are characterized by their very narrow width. 

GMIDx has an algorithm that discriminates between true peaks and spikes, although, 
occasionally, the analyst may encounter a spike called as an allele. While the signal spike 
does not result from an actual DNA fragment, the software cannot always make this 
distinction and therefore calculates a size in base pairs for the spike. 

 

COPYRIGHT © 20 16 

VIRGINIA 
DEPARTMENT 

OF 
FORENSIC SCIENCE 

UNCONTROLLED 
COPY 



4 Analysis and Interpretation of Powerplex® Fusion System CE Data 
 

Data Bank PowerPlex® Fusion Procedures Manual DFS Document 211-D450 
Issued by Biology Program Manager Revision 1 
Issue Date: 28-March-2016 Page 29 of 56 

4.11.6 Other artifact peaks can be observed at some of the PowerPlex® Fusion System loci. Low-level products 
can be seen in the n–2 and n+2 positions with some loci such as D1S1656, D13S317, D18S51, D21S11, 
D7S820, D5S818, D12S391 and D19S433. N–1 peaks are sometimes present at Amelogenin and 
D2S441. N-3 peaks are sometimes present at D12S391. Amplification-independent artifacts may be 
observed in template and non-template samples in the fluorescein (FL) channel at 64–65, 69–71 and 88–
90 bases and in the JOE channel at 74–76 bases. Artifact peaks may be seen outside the locus panels in 
the FL channel at 70–74 bases, in the TMR-ET channel at 66–68 bases and in the CXR-ET channel at 
58–65 bases. Artifacts that may be seen within the locus panels include allele 5 (84 bases) in D16S539 
and peaks at 71–73 and 75–77 bases in TH01, 214 bases in D18S51 and 247 bases in D2S1338. These 
artifacts are typically below common minimum thresholds. (Information taken from The PowerPlex® Fusion System 
Technical Manual, Promega, rev 10/12) 

 
4.12 Microvariant/Off Ladder Variant Interpretation and Nomenclature 
 

4.12.1 If an allele is labeled as “off ladder” or “OL”, careful review of the data should be conducted to 
determine if the allele is truly a microvariant/off-ladder allele or the allele is mislabeled (most commonly 
multiple alleles are mislabeled in that instance.) 

 
4.12.1.1 The allelic ladders and size standard for the given sample should be reviewed for accurate 

calling. If multiple alleles are mislabeled, this is generally the cause. 
 

4.12.2 If a true microvariant or other off-ladder allele is observed (and, if necessary on a sample by sample 
basis, confirmed by re-injection and/or re-amplification of the sample), the nomenclature described 
below will be used. 

 
4.12.3 If the allele is not labeled by the GMIDx software, then the marker range must be changed so that the 

allele can be labeled. Approval for this change must be obtained from the Forensic Biology Program 
Manager or designee and documentation will be maintained in the plate file. Caution must be taken to 
ensure the marker range setting is restored to its original setting after the peak is labeled. 

 
4.12.4 If any allele designation is changed from “OL” to a custom designation, then “FROM OL” must be 

entered into the Allele edit comment. Figure 8 below shows how the Plot Settings 
Editor>Labels>Custom allele must be set in order to display the allele edit comment for microvariants. 

 

 
 

Figure 8. “Labels” screen of the Plot Settings Editor. 
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4.12.5 If an allele is seen in a region “off ladder” or OL alleles, i.e., larger than the largest allelic ladder peak of 
the largest molecular weight (MW) locus on the electropherogram, smaller than the smallest allelic 
ladder peak of the smallest MW locus on the electropherogram, or between loci, an allele designation 
based upon the nomenclature referenced below will be used. 

  
4.12.5.1 If the allele is seen to the right (higher MW) of the largest allelic ladder peak of the largest 

MW locus, it will be assigned the type of the largest allele of the allelic ladder with a greater 
than sign (>). 

 
4.12.5.2 If the allele is seen to the left of the smallest allelic ladder peak of the smallest MW locus, the 

allele will be assigned the type of the smallest allele of the allelic ladder with a less than sign 
(<). The "OL" value on the electropherogram will be manually changed to reflect the allele 
designation. 

 
4.12.5.3 If an allele is seen between two loci and either the locus to the right OR left of the peak 

contains two peaks, the allele will be considered to belong with the locus not containing two 
peaks. The assignment of the allele designation will be based upon the nomenclature 
referenced below. 

 
4.12.5.3.1 If the allele is to the right of the largest allelic ladder peak of the locus not 

containing two peaks, it will be assigned the type of the largest allelic ladder 
peak of the locus with a greater than sign (>).The "OL" value will be manually 
changed to reflect the allele designation. 

 
4.12.5.3.2 If the allele is smaller than the smallest allelic ladder peak of the locus not 

containing two peaks, the allele will be assigned the type of the smallest allelic 
ladder peak of the locus with a less than sign (<). The "OL" value will be 
manually changed to reflect the allele designation. 

 
4.12.5.4 If an allele is seen between two loci and neither the higher nor lower MW locus contains two 

alleles, follow the guidelines outlined below. 
 

4.12.5.4.1 The base pair size for the allele in question will be compared to the base pair 
values for the largest allelic ladder peak of the lower molecular weight locus and 
to the smallest allelic ladder peak of the higher molecular weight locus.  

 
4.12.5.4.2 An evaluation of the physical location of the allele in question with respect to 

the higher and lower molecular weight loci will be conducted. 
 

4.12.5.4.3 An evaluation of the RFU values of the peaks in question may also help 
determine to which locus it belongs. 

 
4.12.5.4.4 The allele in question will be considered to belong to the locus which is 

generally closest in proximity and falls within an appropriate size distance from 
the locus (i.e., one or two repeat units from the largest/smallest allelic ladder 
peak. 

 
4.12.5.4.5 Once it has been determined to which locus the allele belongs, if the allele is 

larger than the largest allelic ladder peak it will be assigned the type of the 
largest allele of the allelic ladder with a greater than sign (>). If the allele is 
smaller than the smallest allelic ladder peak, the allele will be assigned the type 
of the smallest allele of the allelic ladder with a less than sign (<). The "OL" 
value on the electropherogram will be manually changed to reflect the allele 
designation. 

 
4.12.5.5 If an allele is less than 500 bp in size, is visually between two allelic ladder peaks of the same 

locus, the GMIDx program generates a value “off ladder”. The allele will be considered to be 
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a microvariant. The allele will be assigned an allele designation of the lower repeat value 
followed by the number of bases in the incomplete repeat.  

 
4.12.5.5.1 Example: an allele that migrates one base pair below the D16S539 14 allele will 

be designated as a D16S539 13.3. The "off ladder" value on the 
electropherogram will be manually changed to reflect the allele designation and 
the comment “FROM OL” will be added at the prompt. 

 
4.12.5.5.2 To determine a microvariant allele call in the GMIDx software, highlight the 

sample in question and an allelic ladder under the “Samples” tab. Click on 
“View plots” and magnify the peak in question heavily. The ladder will also 
magnify automatically. Show bins, if needed, by clicking on “Bins” under the 
“View” header. The bin will appear as gray shading behind each peak. Compare 
the base pair size of the peak in question to the surrounding known ladder 
allele(s) to determine the size of the peak. 

 
4.12.5.5.2.1 Microvariants not represented in the allelic ladder may be re-

injected and/or re-amplified, if necessary, on a sample by 
sample basis in order to confirm the base pair size of the 
fragment. 

 
4.13 Gender 
 

To indicate the gender of the contributor of a particular biological sample the Amelogenin locus may be used. A 
biological sample exhibiting a single peak at approximately 84 bp (X allele) will generally be considered to have 
originated from a female individual. A biological sample exhibiting a peak at approximately 84 bp (X allele) and a 
peak at approximately 90 bp (Y allele) will generally be considered to have originated from a male individual. The 
PowerPlex® Fusion system also contains the YSTR locus, DYS391, which may also be used for sex determination. 
If the Amelogenin result does not match the expected DYS391 result, the allele determination will be made on a 
case-by-case basis. The sample may be re-analyzed if deemed necessary. 
 

4.14 Peak Height Ratio 
 

When a peak with a high rfu value and a peak with a low rfu value are observed within a single locus and the 
peaks are separated by greater than one repeat unit, the difference in peak height could be the result of the inability 
of the primer to perfectly hybridize to the template in the flanking region of one of the alleles. In order to 
determine if a DNA profile containing peaks with a difference in intensity is a result of primer mispairing or a 
mixture of biological material from more than one source, the analyst must take into account all of the loci, use 
experience and/or the heterozygous percent intensity values to make an informed decision. Databank samples are 
expected to be single source; however, an evaluation of the heterozygous percentage may be appropriate in 
instances where the sample may be contaminated. 
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4.15 File Transfer 
 

If the project file must be transferred to another computer, the GMIDx project must first be exported. 
 
4.15.1 Under the Tools drop-down window, select GMIDx Manager and the following window will open up 

(Figure 9). 
 

 
 

Figure 9. GMIDx Manager 
 

4.15.1.1 Highlight the project file that is to be exported and select “export”. The project will be saved 
to the location and file folder designated. Transfer the project file to the appropriate 
medium/server for transfer to another computer workstation. 

 
4.15.1.2 To open the project file at another computer workstation, open GMIDx and then open 

GeneMapper Manager as shown in Figure 7. Select “import” and browse to find the desired 
file. Select File>Open Project and find your project in the file list. 

 
4.16 Printing the Results 
 

4.16.1 If a printed copy of the electropherogram is desired, after a review of each allele call in the samples plot, 
the x- and y-axes should be set accordingly for printing (as shown below). If the axis needs to be 
changed, right-click on the axis to display the scale settings. For printing purposes, the scale setting may 
be modified, if necessary, to allow visualization of specific characteristics of a particular 
electropherogram. 

 
X-axis = approximately 60bp – 520bp 
Negative Control or Reagent Blank: Y-axis = 0 – 100 RFU 
Samples, Positive Control, and Allelic Ladders: Y-axis = scaled to largest peak 
 

4.16.2 Print the electropherogram by File>Print. 
 

4.16.3 Should additional documentation be necessary to support an allele designation, other views of the data 
(such as a zoomed-in view of an electropherogram) may be printed, at the analyst’s discretion. 

 
REFERENCES 

 
1. PowerPlex Fusion System Technical Manual, Promega, rev. 10/12.
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APPENDIX A – CONVERSION FACTORS AND OTHER USEFUL INFORMATION 
 
I. CONVERSION FACTORS 
 

One microgram = 1 µg = 1 x 10-6 g = 1000 ng 
 
One nanogram = 1 ng = 1 x 10-9 g = 1000 pg 
 
One picogram = 1 pg = 1 x 10-12 g = 1 x 10-3 ng  
 
One liter = 1 L = 1000 mL 
 
One milliliter = 1 mL = 1 x 10-3 (0.001) L = 1000 µL 
 
One microliter = 1 µL = 0.001 mL = 1 x 10-3 mL = 1 x 10-6 L 

 
II. CONCENTRATIONS 
 

A. Concentration can be expressed several ways: 
 

1. Weight percent = (mass A/total mass of solution) x 100 
 

or simplified:  Wt %A = (gA/100 mL of solution) x 100 
 

2. Volume percent = (volume A/total volume of solution) x 100 
 

or simplified: Volume %A = (volumeA/100 mL of solution) x 100 
 

3. Molarity (M):  M = no. moles solute A/no. liters solution  
 
            = molecular weight of solute A in 1000 mL solution 
 
            where 1 mole of A = 1 gram formula weight of A 
 
 

4. Normality (N) = no. MW/no. liters solution 
 

where in acid-base reactions:  
 

MW acid = weight of acid which reacts with 1 mole of OH- 
MW base = weight of base which reacts with 1 mole of H+ 

 
The normality of a given reagent depends on the reaction in which it participates. (Example: 1 L of 1M 
H3PO4 which can have N = 1, 2 or 3 depending upon the reaction in which it is involved.) Because of am-
biguities, the concept of normality is to be used carefully. 

 
B. Examples: 

 
1. Prepare 50% solution of polyethylene glycol (PEG): 

 
Place 50 g of PEG in a flask and bring to a volume of 100 mL with H2O. 
 
Wt % PEG = (50 g/100 mL) x 100 = 50% 
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2. Prepare 100 mL of 2M HCl from a stock solution of 12M HCl. (The question is how much stock 
solution of 12M HCl is needed?) 

 
Conc of Stock Soln = Cs = 12M Conc of Final Soln = Cf = 2M 
 
Volume of Stock Soln = Vs = ?  Volume of Final Soln = Vf = 0.1 L 
 
Cs • Vs = Cf • Vf 
 
Vs = (Cf • Vf)/Cs = 2(0.1)/12 = 0.2/12 = 0.0167 L 
 
Vs = 0.0167 L = 16.7 mL 
 
Answer:  Take 16.7 mL of 12M HCl and dilute to final volume of 100 mL to give 2M HCl.
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APPENDIX B - REAGENTS 
 
1. This appendix describes the preparation of reagents necessary for the DNA analysis. For each reagent listed, the 

company and catalog number is included. As a reagent is prepared, it will be labeled to include the following 
information: 

 
 Identity 
 Concentration 
 Lot number 
 Date of preparation 
 Initials of preparer 
  Date of expiration 
 

and if appropriate:  
 
 Date of autoclaving 
 Storage requirements 
   
2. All reagents will be prepared with Type I water, unless otherwise stated. 
 
3. All chemicals and reagents will be stored according to the manufacturers' specifications. All chemicals containing 

biologicals will be disposed of in biohazard bags. Unless otherwise stated, all other reagents used in Data Bank 
operations can be disposed of in the laboratory sink. 

 
4. Any changes in chemical supply companies will be carefully checked by the Section Supervisor to ensure the 

chemical being provided meets the specifications necessary for the reagent. Any changes in chemical supply 
companies will be brought to the Forensic Biology Program Manager’s attention so the list can be updated as 
necessary. 

 
5. Concentrations preceding reagent components reflect the final concentrations of that specific component in the 

resulting mixture. 
 
6. When a reagent is diluted and used by a number of analysts and retained, a lot number must be created and the 

reagent must be traceable to the reagent log. The container with the diluted reagent must contain the reagent stock 
lot number, the date the dilution was prepared, and the initials of the individual preparing the dilution. If a stock 
solution is diluted and used once and discarded or the dilution is used only by the analyst preparing the dilution, a 
new lot number does not need to be assigned or recorded in the reagent log. The original reagent stock lot number 
will be used. 

 
ANODE BUFFER CONTAINER 

Expiration date: Manufacturer’s expiration date 
Purchased from Applied Biosystems, Foster City, CA. PN 4393925  

 
CATHODE BUFFER CONTAINER 

Expiration date: Manufacturer’s expiration date 
Purchased from Applied Biosystems, Foster City, CA. PN 4408256 

 
CONDITIONING REAGENT 

Expiration date: Manufacturer’s expiration date 
Purchased from Applied Biosystems, Foster City, CA. PN 4409543 

 
ETHANOL, 95% 

Expiration date: Manufacturer’s expiration date if listed, otherwise 3 years from date of receipt 
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HI-DITM FORMAMIDE 
Expiration date: Manufacturer's expiration date    
Purchased from Applied Biosystems, Inc., Foster City, CA, PN 4311230, 25 mL each. Aliquot into 500 µL aliquots 
and store at -20oC. 

 
PERFORMANCE OPTIMIZED POLYMER – 4 (POP-4) 

Expiration date: Manufacturer’s expiration date 
Purchased from Applied Biosystems, Foster City, CA. PN 4393715 (384 samples) OR PN 4393710 (960 samples) 

 
PHOSPHATE-BUFFERED SALINE (PBS), 1X, pH 7.2 

Expiration date: Manufacturer’s expiration date if listed, otherwise 3 years from date of receipt 
 
POWERPLEX FUSION SYSTEM KIT 

Expiration date: Manufacturer’s expiration date 
Purchased from Promega, Madison, WI, Catalog Number DC2402 for 200 reaction kit or DC2408 for 800 reaction 
kit. 
Kit components included (expiration date same as kit unless specified): 

• POWERPLEX FUSION 5X MASTER MIX 
• POWERPLEX FUSION 5X PRIMER PAIR MIX 
• WATER, AMPLIFICATION GRADE 
• 2800M CONTROL DNA, 10 ng/µl 
• POWERPLEX FUSION ALLELIC LADDER MIX 
• CC5 INTERNAL LANE STANDARD 500 

 
POWERPLEX 5-DYE MATRIX STANDARDS, 3100/3130  

Expiration date: Manufacturer’s expiration date  
Purchased from Promega, Madison, WI. Catalog Number DG4700. 

 
PUNCHSOLUTIONTM KIT 

Expiration date: Manufacturer’s expiration date  
Purchased from Promega, Madison, WI. Catalog Number DC9271. 

 
QIAamp® DNA BLOOD MINI KIT 

Expiration date: Refer to individual kit component expiration dates. 
Purchased from QIAGEN, Inc., Valencia, CA, Catalog number 51104 for the 50 sample kit OR 51106 for 250 
sample kit.  
Kit components include: 

• QIAGEN® AL LYSIS BUFFER - Expiration date: Twelve months from date of receipt 
• QIAGEN® AW1 WASH BUFFER (concentrate) - Expiration date: Twelve months from date of receipt. 

Dilute according to manufacturer’s instructions before initial use. 
• QIAGEN® AW2 WASH BUFFER (concentrate) - Expiration date: Twelve months from date of receipt. 

Dilute according to manufacturer’s instructions before initial use. 
• QIAGEN® AE ELUTION BUFFER – contained in the kit, but not used in Data Bank protocols 
• QIAGEN® PROTEASE - Expiration date: 6 months after sample is reconstituted if stored at –20 °C, 2 

months after sample is reconstituted if stored at 4 °C, or twelve months from date of receipt, whichever 
comes first. Reconstitute with supplied QIAGEN® protease solvent before initial use according to 
manufacturer’s instructions. 
If the QIAGEN® Protease is purchased separately from the kit, then it is to be reconstituted with 7 mL of 
Type I water for each 125 mg bottle. 

• QIAGEN® PROTEASE SOLVENT - Expiration date: Twelve months from date of receipt
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APPENDIX C - MAINTENANCE OF THE ABI 3500XL GENETIC ANALYZER 

1 The weekly and monthly maintenance requirements for the 3500xl are specified in Table 1. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Table 1.  Maintenance Tasks 

1.1 Daily or pre-run tasks are specified in Section 3.6.8 of this manual 

 

 

 

 

 

Task Frequency 

Restart the computer and instrument At each polymer change or as needed 
 

Use a lab wipe to clean the anode buffer container valve pin 
assembly on the polymer delivery pump 
 

Monthly or as needed 

Run the Wash Pump and Channels Wizard (conditioning reagent) 
 Monthly or as needed 

Flush the pump trap 
 Monthly or as needed 

Empty the water trap waste container. The waste container is to 
the right of the pump block Monthly or as needed 

Replace cathode buffer septa Monthly or as needed 
 

Clean the autosampler and drip tray Monthly or as needed 
 

Remove dried polymer from the capillary tips with a lint-free 
wipe moistened with deionized water 
 

Monthly or as needed 
 

Defragment the hard drive 
Monthly or before fragmentation reaches 
10% 
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2 Wizards - Wizards are automated instrument processes which allow the user to perform a variety of tasks. Each 
wizard has been designed with specific instructions to achieve the purpose of the wizard. The wizards are accessed 
by selecting the desired wizard from the “Maintenance Wizards” menu as shown in Figure 1. 

 
 

Figure 1. Wizard menu in the data collection software. 

The wizards include: 

2.1 Install a capillary array 

2.1.1 Select Install Capillary Array wizard. Follow directions given in the wizard to change or install a 
capillary array. This wizard will take 15 to 45 minutes to complete. 

2.2 Remove bubbles from the polymer pump 

2.2.1 To remove bubbles from the polymer pump fluid path that travel from the polymer pouch through the 
pump, array port, and the anode buffer container, select Remove Bubbles wizard. Follow the directions 
given in the wizard. This wizard will take 5 to 15 minutes to complete. 

2.3 Wash the pump chamber and channels 

2.3.1 Conditioning reagent is used for priming the polymer pump, washing the polymer pump between 
polymer type changes, and during instrument shut down. Each pouch has adequate volume for a one-time 
use. 

2.3.2 Select Wash pump chamber and channels wizard. Follow directions given in the wizard to wash the 
pump chamber and channels. The procedure takes about 25 minutes to complete. 

2.3.3 Record the date of the conditioning reagent run, lot number and expiration of the reagent pouch in the 
appropriate QC log. 
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2.4 Fill the array with polymer 

2.4.1 To fill the capillary array with the same type of polymer, in the Data Collection Software, select 
Maintenance Wizards>Fill the Array with fresh Polymer. Follow the directions given in the wizard. 

2.5 Replenish the polymer installed on the instrument 

2.5.1 Select Replenish Polymer Wizard. Follow the directions given in the wizard to load fresh polymer on the 
instrument. This wizard takes 10 to 20 minutes to complete.  

2.5.2 Allow the new polymer pouch to equilibrate to room temperature prior to installing on the instrument. 
Verify that the polymer has not expired as the instrument WILL allow you to install polymer that is past 
the manufacturer’s expiration. 

2.5.3 Click “Refresh” on the dashboard to update the screen. 

2.5.4 Record the date, lot number, and expiration date on the 3500xl Reagent Log. 

2.6 Change the type of polymer installed on the instrument 

2.6.1 All DFS DNA Data Bank validated procedures use POP4. This wizard will not be used. 

2.7 Shutdown the instrument 

2.7.1 For short-term and long-term shutdown, select Shutdown the instrument wizard. Follow the directions 
given in the wizard. This wizard takes 60 minutes to complete. 

3 Restarting the computer 

3.1 The computer and instrument will both be shut down and restarted each time the polymer is changed (Replenish 
polymer wizard). This action will be recorded on the 3500xl Reagent Log. 

4 Defragment the hard drive 

4.1 Go to Start>Programs>Accessories>System Tools>Disk Defragmenter and follow the prompts. 

4.1.1 You can click “Analyze” to see if you should defragment or not. 

5 Changing the Anode Buffer Container (ABC) 

5.1 The lot number of the ABC is recorded in the raw data of each electropherogram. Verify that the buffer level is 
at or above the fill line and check that the seal is intact. 

5.2 Invert the ABC, and then tilt it slightly to make sure most of the buffer is in the larger side of the container. 
There should be less than 1 ml of the buffer remaining in the smaller side of the container. 

5.3 Peel off the seal at the top of the ABC and place the ABC into the Anode end of the instrument. 

5.4 Click “Refresh” on the dashboard to update the screen. 

6 Changing the Cathode Buffer Container (CBC) 

6.1 The lot number of the CBC is recorded in the raw data of each electropherogram. Press the Tray button on the 
instrument to bring the old CBC forward. Remove the septas from the old container prior to discarding. 

6.2 Verify that the buffer level is at or above the fill line and check that the seal is intact. 
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6.3 Tilt the CBC back and forth gently to ensure that the buffer is evenly distributed across the top of the baffles. 

6.4 Peel off the seal at the top of the CBC. Wipe off any buffer to make sure it is dry. 

6.5 Align and place the appropriate septa both sides. Push the septa lightly into the holes to start and then push 
firmly to seat the septa. Install the CBC on the autosampler. 

6.6 Click “Refresh” on the dashboard to update the screen. 

7 Flush the water trap (pump trap) 

7.1 The water trap must be flushed once per month to prolong the life of the pump and to clean any diluted 
polymer. 

7.2 Fill a 20mL, Luer lock syringe with distilled or deionized water. Expel bubbles from the syringe. Do not use a 
syringe smaller than 20mL as the pressure generated will be too great. 

7.3 Attach the syringe to the forward-facing Luer fitting at the top of the pump block. Hold the fitting with one 
hand while threading the syringe onto the fitting with the other hand. 

7.4 Open the Luer fitting by grasping the body of the fitting and turning it to loosen. Turn counterclockwise 
approximately one-half turn. 

7.5 DO NOT USE EXCESSIVE FORCE when you push the syringe plunger as this may damage the trap seals. 
Take approximately 30 seconds to flush 5 mL of water through the trap. 

7.6 Remove the syringe from the Luer fitting. Hold the fitting with one hand while turning the syringe 
counterclockwise with the other hand. 

7.7 Close the Luer fitting by lightly turning clockwise until the fitting seals against the block. 

8 Performing a spatial 

8.1 A spatial calibration is used by the instrument to correlate the signal from each capillary with the signal detected 
by the CCD camera. A spatial must be performed after any of the following events: 

• Replaced the capillary array 
• Opened the detector door or moved the detection cell 
• Moved the instrument 
• Service engineer performed an optical service procedure, such as realigned or replaced the laser or CCD 

camera or mirrors on the instrument. 

8.2 To access the Spatial Calibration screen, select Maintenance>Spatial Calibration in the navigation pane. 

8.3 Select “No Fill” or “Fill” to fill the array with polymer before starting the calibration. 

8.4 Check “Perform QC checks”. The software will check each capillary against the specified range for spacing and 
intensity. 

8.5 Click Start Calibration. The display updates as the run progresses. 

8.6 A Spatial QC Check error message is displayed if: 

• The average peak height or individual peak height is below the threshold 
• Uniformity or capillary spacing exceeds the threshold 
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8.7 When the run is complete, evaluate the calibration profile to ensure that you see: 

• One sharp peak for each capillary. Small shoulders are acceptable 
• One marker (+) at the apex of every peak. No off-apex markers. 
• An even peak profiles (all peaks about the same height)  

8.8 If the results meet the above criteria, click Accept Results. An example of a successful spatial profile is seen in 
Figure 2. 

  

Figure 2.  An example of an acceptable spatial calibration profile. 

8.9 If the results do not meet the above criteria, click Reject Results, then go to “Spatial Calibration 
Troubleshooting” in the Applied Biosystems ®3500xl Genetic Analyzer user guide. 

8.10 Only the most recent spatial calibration is maintained in the software. The software does not save historical 
calibration results. 

9 Performing a spectral 

9.1 The spectral calibration should be performed on dye set G5. Once generated, this file is applied during sample 
detection to calculate the spectral overlap between the five different dyes and separate the raw fluorescent 
signals into individual dye signals. 

9.2 Perform a spectral for each dye set/polymer type combination you will use. A spectral must also be performed 
after any of the following events: 

• Replaced the capillary array 
• If a decrease is seen in spectral separation (pull-up in peaks) in the raw or analyzed data 
• Service engineer performed an optical service procedure, such as realigned or replaced the laser or CCD 

camera or mirrors on the instrument 
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9.3 If you have not already done so, perform a spatial calibration. 

9.4 Pre-heat the oven to 60°C. This is very important – preheating helps mitigate subtle first-run migration rate 
effects. 

9.5 Then check consumables status on the dashboard. Ensure that: 

• Consumables are not expired 
• Adequate injections remain 

9.6 Prepare the matrix standard for PowerPlex® Fusion 

9.6.1 Remove the 5-dye matrix standards from the freezer, thaw, and vortex to mix thoroughly, but do NOT 
centrifuge.  

9.6.2 Initial dilution of concentrated fragments: Dilute each of the concentrated dyes 1:10 with nuclease-
free water (ex. 1 µL concentrated dye + 9 µL nuclease-free water). Vortex 5-10 seconds to mix. 

9.6.3 Fragment mix (using 1:10 dilutions of matrix standards): Using these 1:10 dilutions, mix 7 µL of 
each diluted dye with 665 µL Hi-DiTM formamide for a total volume of 700 µL. 

9.6.4 Vortex the formamide/matrix standard mixture thoroughly. Do not centrifuge the mixture. 

9.7 Loading the samples on the 3500xl 

9.7.1 Add 25 µL of the formamide/dye mix to each well of the first three columns of a 96-well plate. 

9.7.2 After placing the septa on the plate, briefly centrifuge the plate to remove bubbles. 

9.7.3 Denature the samples at 95°C for 3 minutes then immediately chill the plate in a freezer block for 3 
minutes. 

9.7.4 Place the plate in the plate base and cover with the plate retainer. Place the plate assembly in Position A 
on the autosampler with the label facing you. 

9.8 Instrument Preparation 

9.8.1 To perform the spectral calibration with the Promega 5-dye chemistry, go to the Maintenance tab, select 
“Spectral”, and under the Calibration Run tab, choose the appropriate fields in Calibration settings as 
indicated below: 

• Number of wells: 96 
• Chemistry standard: Matrix standard 
• Plate Position: A 
• Dye Set: PP 5-dye 
• Allow borrowing: checked 

9.8.2 Click Start Run. 
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9.9 Evaluating the Spectral calibration run 

9.9.1 Figure 3 shows a complete and successful spectral run. 

 

Figure 3. Completed spectral run 

9.9.2 Passing and failing capillaries are shown in green and red, respectively. Borrowed capillaries are shown 
in yellow with an arrow indicating the adjacent capillary from which results were borrowed. 

9.9.2.1 To display the result for each capillary (spectral data, Quality Value, and Condition Number) 
below the run results table, click a capillary in the table. 

9.9.2.2 A spectral Quality Value reflects the confidence that the individual dye emission signals can be 
separated from the overall measured fluorescent signal. It is a measure of the consistency 
between the final matrix and the data from which it was computed. A Quality Value of 1.0 
indicates high consistency, providing an ideal matrix with no detected pull-up/pull-down peaks. 

9.9.2.3 A Condition Number indicates the amount of overlap between the dye peaks in the fluorescence 
emission spectra of the dyes in the dye set. If there is no overlap in a dye set, the Condition 
Number is 1.0 (ideal), the lowest possible value. The condition number increase with increasing 
peak overlap. 
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9.9.2.4 The PowerPlex® Fusion system uses the G5 dye set. Table 2 shows acceptable ranges. 

 
Dye Set Quality Value Minimum Condition Number Maximum 
AnyDye 0.8 (default) 20.0 (default) 
E 0.95 5.5 
E5 0.95 6.0 
F 0.95 8.5 
G5 0.95 13.5 
J6 0.95 8.0 
Z 0.95 5.5 

Table 2.  Acceptable condition number range and Q-values for analysis of spectral 
calibration data. Acceptable G5 dye set values are highlighted in yellow. 

9.9.3 Examine the data for all capillaries before accepting the spectral calibration. Check that all capillaries 
meet the following criteria: 

9.9.3.1 Order of the peaks in the spectral profile from left to right for 5-dye should be blue-green-
yellow-red-orange as in Figure 4. 

 

Figure 4. Order of peaks in the spectral profile 

9.9.3.2 Order of the peaks in the raw data profile from left to right for 5-dye should be orange-red-
yellow-green-blue as in Figure 5. 

 

Figure 5. Order of peaks in the raw data profile 

9.9.3.3 There should be no extraneous peaks in the raw data profile. 

9.9.3.4 The peak morphology in the spectral profile should have no gross overlaps, dips or other 
irregularities. The peaks should be separate and distinct. 

9.9.4 If any of the above criteria is not met, the calibration run has failed. 

9.10  A spectral calibration can run up to three injections. The number of injections performed depends on the 
number of capillaries that pass or fail during an injection and whether the “Allow Borrowing” option is 
selected. If borrowing is allowed, then the capillaries can share information with adjacent capillaries within 
an injection or between injections. Up to three borrowing events are allowed. 

9.11 Once all capillaries have been reviewed and accepted, click Accept. 

9.12 If the results do not meet the above criteria, click Reject, then go to “Spectral Calibration Troubleshooting” in 
the Applied Biosystem’s ®3500xl Genetic Analyzer user guide. 
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9.13 Only the most recent spectral calibration is maintained in the software. The software does not save historical 
calibration results.  

10 Long periods of inactivity 

10.1 If the ABI 3500xl Genetic Analyzer remains unused for an extended period of time (approximately 2 weeks 
or longer), it is recommended that either a blank run (consisting of only formamide and size standard) be 
completed or the capillary array removed and the capillary ends stored in Type I H2O until further use.COPYRIGHT © 20 16 
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APPENDIX D – STORAGE OF ELECTRONIC DATA 
 
Saving Sample files and Project files 
 
1 Sample files and project files generated by the data bank using the Applied Biosystems, Inc. 3500xl Genetic 

Analyzer and analyzed using the GeneMapper® ID-X software will be saved onto a storage medium and stored 
according to the following procedures. 
 

2 After the data has been technically reviewed and found to be acceptable, the electronic sample files and project files 
will be transferred onto a medium for permanent storage. The storage medium will be labeled appropriately to 
indicate the data files are PowerPlex® Fusion samples, the appropriate plate number, date and analyst’s initials. The 
folders may be deleted from the computer after the data has been stored and a backup copy has been made. 
 

3 The storage medium will then be stored securely with the data bank sample plate documentation in a specified 
location within the laboratory for easy retrieval. 
 

4 If a file(s) needs to be subsequently added to the storage medium for a given plate of data bank samples, the analyst 
will make arrangements with his/her supervisor to have the storage medium retrieved from storage and have the 
file(s) added to the appropriate storage medium.
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APPENDIX E – INITIAL SETUP OF GENEMAPPER® ID-X AND DATA COLLECTION SOFTWARE 
 
After installation of a new 3500xl instrument and installation of the GeneMapperTM ID-X software on a new computer, a 
number of customizations must be made. Displayed below are screen captures for settings in use by the 3500xl 
instruments and the GMIDx software. These settings may also be exported/imported from an established 
instrument/software to a new instrument/software.  
 
For step-by-step directions for set up, the user guide for each system should be consulted (Applied Biosystem’s ® 3500xl 
Genetic Analyzer User Guide, Applied Biosystems ® GeneMapper® ID-X Software User Guide, and PowerPlex® Fusion 
System Technical Manual). 

1 Table 1 shows settings used in creating a dye set for the PowerPlex® Fusion system (3500xl). 

 

Table 1. Initial dye set settings 
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2 Table 2 shows settings used in creating the 24 second Promega 5-dye instrument protocol (3500xl). 

 

Table 2. Initial 24 second instrument protocol settings. 

3 Table 3 shows settings used in creating the 12 second Promega 5-dye instrument protocol (3500xl). 

 

Table 3. Initial 12 second instrument protocol settings. 
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4 Table 4 shows settings used in creating the 24 second Fusion assay (3500xl) 

 

Table 4. Initial 24 second assay settings.  

5 Table 5 shows settings used in creating the 12 second Fusion assay (3500xl). 

 

Table 5. Initial 12 second assay settings. 
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6 Table 6 shows settings used in creating the 12 and 24 second Fusion assay (3500xl). 

 

Table 6. Initial 12 and 24 second assay settings. 

7 Table 7 shows settings used in creating a results group (3500xl). 

 

Table 7. Initial Data Bank results group settings. 
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8 Table 8 shows settings used in creating the file name convention (3500xl). 

 

Table 8. Initial Data Bank file name convention settings. 

9 Table 9 shows settings used in creating the Size Standard (3500xl). 

 

Table 9. Initial size standard settings. 
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10 Table 10 shows settings used in creating the QC protocol – Analysis settings (3500xl). 

 

 

Table 10. Initial settings for QC protocol. 
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11 Table 11 shows settings used in creating the QC protocol – QC settings (3500xl). 

 

Table 11. Initial QC protocol settings. 

12 Table 12 shows settings used in creating the analysis method editor – general tab (GMIDx). 

 

Table 12. Initial settings of the Analysis method editor – general tab. 
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13 Table 13 shows settings used in creating the analysis method editor – allele tab (GMIDx). 

 

Table 13. Initial settings of the Analysis method editor – Allele tab. 

14 Table 14 shows settings used in creating the analysis method editor – peak detector tab (GMIDx). 

 

Table 14. Initial settings of the Analysis method editor – Peak Detector tab. 
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15 Table 15 shows settings used in creating the analysis method editor – peak quality tab (GMIDx). 

 

Table 15. Initial settings of the Analysis method editor – Peak Quality tab. 

16 Table 16 shows settings used in creating the analysis method editor – quality flags tab (GMIDx). 

 

Table 16. Initial settings of the Analysis method editor – SQ & GQ settings tab. 
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17 Table 17 shows settings used in panel manager (GMIDx). 

 

Table 17. Initial panel manager settings. 

18 Table 18 shows settings used for ILS set-up (GMIDx). 

 

Table 18. Initial ILS settings. 
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	WARNING!
	CONVERSION FACTORS
	CONCENTRATIONS
	Concentration can be expressed several ways:
	Weight percent = (mass A/total mass of solution) x 100
	Volume percent = (volume A/total volume of solution) x 100
	Molarity (M):  M = no. moles solute A/no. liters solution

	B. Examples:
	1. Prepare 50% solution of polyethylene glycol (PEG):
	2. Prepare 100 mL of 2M HCl from a stock solution of 12M HCl. (The question is how much stock solution of 12M HCl is needed?)



